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The Icon Work Area is the big window where you edit the icon or cursor.    It is variable in size
and is always larger than the actual icon.    Therefore, each pixel will be displayed as a 
square.



Glossary
Automatic Image Control

Automatic Image Control (AIC) simplifies some of the complexities of dealing with icons. 
Each icon can have multiple images, each image targeted to a specific display type.    
Most users only want to work with the icon image targeted for their display (most often 
32 x 32 pixels, 16 colors).    This feature allows the user to view most icons as having 
only one image, even if more than one image type is physically present in the icon.

Cursor
A cursor is a pointing device used in Windows.    When you move the mouse, the cursor 
acts as a position indicator, constantly pointing to an area of the screen.    In Windows, 
cursors are always monochrome.

Dithered Colors
Windows supports a palette of 16 standard colors which it uses for icons.    Even if your 
display has more colors available, icons can only use these 16 colors.    Dithered colors 
are a technique of creating a pattern made up of individual pixels of various colors that 
gives the illusion of a different color.    Dithered colors are very handy when creating 
icons, and can also be used to create interesting patterned effects.      The major 
disadvantage of dithered colors is that they are not as "crisp" as the 16 solid colors.

File Type
Icon Creator supports three basic file types:

Icon Files (.ICO) are the normal files in which icons are stored.    Each file may only store 
a single icon (although that icon may have multiple images).    These files may be used 
to attach icons to applications in Program Manager, and also can be used by application 
developers.

Application / Library Files are standard Windows applications and specialized icon 
libraries that hold from one to many icons.    It is possible to change the icons in a 
Windows application, and have that application use the new icon when it is executed.

Cursor Files (.CUR) are the normal files in which cursors are stored.    You may use these 
files with Cursor Control (included with Icon Creator).

Icon
A graphical representation of various elements in Windows, such as disk drives, 
applications, and documents.

Image
In the context of icons, an image is a "icon" targeted to a specific display type.    For 
example, there is a 32x16 pixel monochrome image specifically for CGA displays, and 
the more common 32x32 pixel 16 color image for EGA and VGA color displays.    Each 
logical icon can be made up of several images.      Icons and their images are often 
confused.

Resource
In the context of Icon Creator, resources are icons and cursors.    There are many other 
resources used in Windows, but they are not relevant to Icon Creator.

Transparency
An icon is actually ALWAYS a square picture.    Transparency is a "color" used when 



creating an icon that allows the screen color underneath to show through.    By using 
transparency, it is possible to create icons that don't look square, which makes them 
much more effective.    The two flavors of transparency are normal transparency (or the 
screen color below each pixel), and inverse transparency (or the opposite screen color 
below each pixel).





File Menu
The commands under the File Menu deal with the icon or cursor as a file.    This includes 
retrieving and saving files in various ways and displaying information about the file as 
well as exiting the program.

For more information, select the File Menu command name.

New Icon
New Cursor
Open
Open Next
Open Previous
Save
Save As
Save Into
Display Resource Statistics
Convert Icons To OS/2 Format
Exit



File | New Icon
Clears the Icon Work Area to allow for the creation of a new icon. 

If selected while the Icon Work Area contains unsaved work    you will    be queried if you 
wish to save the changes. 

If    Automatic Image Control is not active you will be prompted to choose an image type 
before proceeding. 



File | New Cursor
Clears the Icon Work Area to allow for the creation of a new cursor. 

If selected while the Icon Work Area contains unsaved work    you will    be queried if you 
wish to save the changes.

Note that because a cursor is always monochrome, the color choices will be limited to 
black, white, transparent, and inverse transparent.



File | Open
Allows an existing icon or cursor to be opened for the purpose of editing. 

If selected while the Icon Work Area contains unsaved work    you will    be queried if you 
wish to save the changes.

When selecting a file to edit you may select from one of three File Types.    As you select 
each file name in the listbox, the available icon(s) or cursor(s) are displayed.    If    an 
Application / Library file contains more than one icon, a scroll bar will appear which allows
you to select which icon you want to edit.

Shortcut:    CTRL+O.    Also, it is possible to open an existing icon from an .ICO file or an 
existing cursor from a .CUR file by double-clicking on the desired file from within the 
Windows File Manager (or replacement).    This will automatically execute Icon Creator and
load the desired icon or cursor.    Note that if Icon Creator is already running, another 
instance (copy) will be invoked.



File | Open Next
Allows    the next .ICO or .CUR file in the subdirectory, or the next icon within an 
Application/Library file, to be opened without having to use the File | Open 
dialog box.

If the .ICO or .CUR file is the last one listed in the subdirectory, or if the current icon is the 
last one within an application or library file, or if no file has been opened, this option is 
"grayed" (unavailable).

Shortcut:    ALT+N



File | Open Previous
Allows the previous .ICO or .CUR file in the subdirectory, or the preceding icon 
within an application or library file, to be opened without having to use the File 
| Open dialog box.

If the icon is the first .ICO or .CUR    file in the subdirectory or if the icon is the first one 
within an application or library file, or if no file has been opened, this option is "grayed" 
(unavailable).

Shortcut:  ALT+P



File | Save
Allows you to save your icons and cursors.

If you created the icon "from scratch" or used the File | New Icon    or the    File | New 
Cursor command to start working on the icon, your work will be named "(Untitled)."    In 
this case, the Save dialog box will appear asking you to provide the File Name and specify
the Directory to which the file will be saved. Refer to File | Save As for more details. If you 
have already saved your work under a specified file name, or if you opened an existing 
icon, your work will automatically be saved into the file name specified on the Windows 
title bar without having to use the Save dialog box.    If you do not wish the icon in that file
to be overwritten, use the File | Save As    command.

Shortcut:    CTRL+S



File | Save As
Allows you to specify an alternate file name for modifications made to an icon 
or cursor.

Selecting this command will bring up a dialog box.    Here you will note that the current file
name appears in the top line of the box (if the file is not "(Untitled)").    By typing in the 
new name (or selecting a file from the list box) and clicking the Save button you will save 
your modifications into another file. If you type a file name without an extension, the .ICO 
or .CUR extension will be automatically added, depending upon the type of resource 
currently being edited. If the file name entered    is identical to an existing file in the same 
directory, you will be asked if you want to overwrite the file. 

Note that if you want to save into an Application / Library file, you must use the File | Save
Into command.



File | Save Into
Allows you to replace an existing icon in an Application/Library file.

Selecting this command will bring up a dialog box.    Use the Directories and Files boxes to 
locate the desired file.      The image that is displayed in the Icon box in the lower right 
corner is the one that will be replaced, so be sure to use the scroll bar to select the 
appropriate position.    

A backup file is created if the file type is an .EXE or .DLL, and if a backup doesn't already 
exist,.    It will have the extension ".EX~" or ".DL~ ".    This backup copy will allow you to 
return the application to it's original state if required.

There are a number of restrictions when saving an icon into Application / Library files.    
The most important is that the image type(s) must match the icon being saved.    In other 
words, you can not save a color icon into an application file that only has icons with 
monochrome images.    For more information, please refer to the Icon Creator User's 
Guide.



File | Display Resource Statistics
Provides important information about the resource (icon or cursor) you are 
working with.

This information will include the file name, the number of icons (for Application/Library 
files), the number of images in the current icon, details of the current image (width, 
height, number of colors) and whether or not the image has been saved since it was last 
modified.    



File | Convert Icons to OS/2 Format
Allows you to convert your Windows icons for use in OS/2.

This option allows you to convert Windows icons for use under OS/2 Presentation 
Manager.    Support is provided for OS/2 Versions 1.2 and above.

 This option permanently converts the file format of the icon and cannot be reversed.    
Always work on backup copies of icons so that you will still have the Windows icons 
available. A dialog box    is displayed where you may select Windows icons to be 
converted to OS/2 Presentation Manager Icons.    This command allows multiple file 
selections,    permitting many files to be converted at once.    After you have selected the 
files, clicking Convert will begin the process. Before actually converting the files, Icon 
Creator presents a warning screen which reminds you to work on backup copies of your 
icons and asks if you wish to proceed.    



File | Exit
Allows you to quit Icon Creator and return to Windows.

If you have not saved your current work, a dialog box will appear asking if you wish to 
save the changes you have made to the current file. 

Shortcut:    ALT+F4



Edit Menu
The Edit menu includes commands that enable you to move text to and from the 
clipboard, to delete text, and to undo a previous editing operation.

For more information, select the Edit menu command name.

Undo
Redo
Capture
Cut
Copy
Paste
Clear
Restore Icon



Edit | Undo
Allows you to "take back" the last command (or commands) performed in the 
Icon Work area.

When working with an icon or cursor, it may be necessary to "undo" or "take back" 
changes you have made. By executing this command, the last change to your icon or 
cursor will be removed.    Executing the command again will undo the second to the last 
change.    You may set the "levels" or number of operations which may be undone in the 
ICREATOR.INI file. Eight is the default. Also, see the Option | Undo from Selected tool 
section for additional undo    information.

Shortcut:    ALT+Backspace



Edit | Redo
Allows you to restore a command that was "undone" by the Undo command.

If you decide to undo a command and wish to restore it, execute Redo.    Like Undo, Redo 
will restore several levels which have been "undone."    This command is available after an
Undo (or series of Undo's) until you make additional changes to the icon or cursor.

This feature also works with the Option | Undo from Selected tool command.    See this 
section for more information.

Shortcut:    CTRL+Backspace



Edit | Capture
Allows you to "take a picture" of another portion of the Windows screen and 
incorporate it into an icon or cursor.

To use this feature, make sure that the icon, image, or text you wish to capture is 
displayed on the Windows screen.      When you start the capture, the Icon Creator window
will be minimized and the cursor turns to crosshairs.    By clicking    on a corner of the 
image you wish to capture, dragging to the opposite corner, and releasing the mouse, you
send a copy of the selected portion of the screen to the Windows clipboard.    This area is 
indicated by a dashed rectangle.    Once the mouse button is released, the Icon Creator 
window is restored, and the Paste Manager is displayed (unless you captured an area that 
exactly matches the size of the selected area).    The Paste Manager allows you to 
position, crop, or scale the image to suit your tastes.    See the Edit    | Paste section below 
for more information about the Paste Manager.    

The Capture command is useful for creating icons or cursors from pictures displayed on 
the Windows screen by other applications.    Also, a common use is to incorporate text or a
part of a picture into an existing icon or cursor.    

The Paste Manager (see description under Edit | Paste) will paste the captured area to the 
currently selected area.    If you are creating a new icon or cursor, let the selected area 
default to the current image size.    If you are capturing a piece of text (or other small 
area), first select the area you wish to paste into by using the Scissors tool.

Shortcuts:    There are no keyboard shortcuts to execute the Edit/Capture command.    
However, there are some keyboard combinations that make using the Capture command 
much easier.    If you hold the SHIFT key down while you are dragging on the image you 
wish to capture, your capture area will be restricted to a perfect square.    Pressing the 
CTRL key will give you a rectangle that is exactly the size of the selected area (icon-sized 
by default), in addition to allowing you to move the origin of the rectangle around the 
screen.



Edit | Cut
Allows selected areas of your screen to be copied to the Windows clipboard 
while deleting the selected area.

The Cut command makes it easy to transfer icon images, or portions of images to 
different sections of the same icons, different icon files, and even to other Windows 
applications. 

You may use the Scissors tool (from the Tool Bar) to first select a portion of the image you 
wish to cut.    The default selection is the entire image.

The area that is cut will be filled-in with the currently selected background color.

Shortcut:    Shift+Del (the Delete key)



Edit | Copy
Allows selected areas of your screen to be copied to the Windows clipboard.

The Cut command makes it easy to transfer icon images, or portions of images to 
different sections of the same icons, different icon files, and even to other Windows 
applications. 

You may use the Scissors tool    (from the Tool Bar) to first select a portion of the image 
you wish to cut.    The default selection is the entire image.

Shortcut:    CTRL+Ins (the Insert key)



Edit | Paste
Allows images from the Windows clipboard to be copied to the Icon Work area.

In order to effectively allow various types of bitmaps to be incorporated into icons and 
cursors, Icon Creator uses a Paste Manager.    Not only will the Paste Manager copy 
bitmaps    from the Windows Clipboard into the icon image, but you can actually control 
how the bitmap is to be pasted.

If you are pasting a bitmap to a selected area that is the same size as the area that you 
cut or copied, simply select this command and the image will appear.

If the size of the bitmap you wish to paste differs from the size of the "paste" area you 
have selected with the Scissors tool, you will be given three choices:

1) Cropping the image, 
2) Stretching or shrinking the image to fit the area you have selected, or 
3) Using Icon Creator's Viewport to select the desired section of the image to be 
displayed.    

This allows for plenty of flexibility in trying to make bitmaps "fit" into the constraints of an
icon image.    When using the Paste Manager, a dialog box will appear, offering these 
three options:

For more details, please refer to the Icon Creator User's Guide.

Shortcut:    Shift+Ins (the Insert key)



Edit | Clear
Allows a fast way to completely erase the Icon Work area.

Selecting this command will "wipe clean" any work that is displayed on the selected 
portion of the Icon Work area.    This blanked icon area will be filled with the currently 
selected background color (the "transparent" color is the default).    If you accidentally 
Clear the work are, simply select Edit | Undo.      

Since the default selection area is the entire image, this command is a excellent way to 
clear the icon and change the background color.

Shortcut:    Del (Delete key)



Edit | Restore Icon
Allows you to revert to the last saved version of the icon you are currently 
working on.

This command serves as a shortcut to return the icon to the same condition as it was 
when last saved on disk.      Restore is one of the few commands that can NOT be undone. 

Shortcut:    Ins (Insert key)



View Menu
The View Menu    controls settings which modify the display and include commands to help
you perform detailed work on an icon or cursor.

For more information, select the View Menu command name.

Show Cursor Position
Show Drawing Dimensions
Show Grid
Show Shadowing
Change Icon Preview Background
Zoom Icon Work Area



View | Show Cursor Position
Toggles the display of the cursor position indicators on or off.

When enabled, the cursor position indicators show the current location of the mouse 
pointer while it is inside the Icon Work Area.    This is useful for detailed work. 

A checkmark will appear next to the command if this feature is presently enabled.



View | Show Drawing Dimensions
Toggles the Drawing Dimensions window on or off.

When enabled, the Drawing Dimensions window shows detailed drawing information 
which is particularly useful when drawing with the rectangle, ellipse, polygon, or scissors 
tools.

A checkmark will appear next to the command if this feature is presently enabled.



View | Show Grid
Toggles the Grid on or off.

When enabled, the grid will overlay a pixel-by-pixel grid on top of the Icon Work Area.    
This is valuable for detailed design work.

A checkmark will appear next to the command if this feature is presently enabled.



View | Show Shadowing
Toggles the Shadowing feature on or off.

By default the Icon Work Area and Icon Preview Area have thick black borders on two 
sides, which gives a three-dimensional shadowing effect.    This is for esthetic purposes 
only and may be disabled if you wish.

A checkmark will appear next to the command if this feature is presently enabled.



View | Change Icon Preview Background
Changes the background color of the Icon Preview Area.

This command is helpful for determining how a particular icon will look when set against 
varying background colors.    This makes it easy to see if your icon will look "washed out" 
when different background colors are selected for your Windows desktop.

The ability to cycle through background colors is also available by single-clicking the 
mouse cursor in the Icon Preview Area.    If you hold it down, the cycling will continue.    
Pressing the left or right mouse button will alternate the direction of cycling.    



View | Zoom Icon Work Area
Displays an enlarged view of the Icon Work Area.

This command makes it easier to perform detailed pixel-by-pixel editing.    After selecting 
this command, you will notice the Icon Work Area is "blown up" to a larger size, giving you
a closer look at the pixels that form the icon.    You will also notice that the color palettes 
and the Tool Bar are removed.    This means that you should select the tool and colors you 
wish to use before executing this command.    You can even make your screen bigger by 
clicking on the Maximize button on the Windows Title bar.    This command toggles on and 
off, so to get your Tool Bar and color palettes back, simply select the command again.

A checkmark will appear next to the command if this feature is presently enabled.

Shortcut:    ALT+Z



Brush Menu
The Brush Menu    controls the selection of brush width used by the various drawing tools.

For more information, select the Brush Menu command name.

Small
Medium
Large
Huge



Brush | Small
Selects the smallest brush (1 by 1 pixel), which is the default.



Brush | Medium
Selects the medium brush, which is 2 by 2 pixels.



Brush | Large
Selects the large brush, which is 3 by 3 pixels.



Brush | Huge
Selects the huge brush, which is 4 by 4 pixels.



Options Menu
Icon Creator features many powerful options that make the task of creating icons and 
cursors easier and more effective.

For more information, select the Options Menu command name.

Test Icon
Border Flood Fills
Smooth Pen Drawing
Tools Squaring
Undo From Last Selected Tool
Automatic Image Control
Edit Dithered Colors
Save Dithered Palette
Load Dithered Palette
Set Cursor Hotspot
Set Preferences



Options | Test Icon
Places a sample of the current icon on the Windows desktop (Toggles on or off).

This command actually allows you to see what your icon will look like on the Windows 
desktop without having to save it, quit Icon Creator, and install it with a program.    When 
you execute this command, the Icon Creator window is minimized, and a copy of the icon 
you are working on is placed on your desktop.    You may then move the icon around to 
see how it looks against different backgrounds.

If you return to Icon Creator and leave the Test Icon on the desktop, you may return to it 
at any time (by Alt-Tabbing, etc.).    Whenever you click on the Test Icon it will be updated 
with the most current version of the icon. 

You may close the Test Icon by a) closing the window, b) selecting the Test Icon command 
again, or 3) exiting Icon Creator.

Note that if you move the Test Icon onto an open window, such as Program Manager, etc., 
you will see a square "hole" in the window that goes to the Windows desktop.    This is a    
normal function of Windows.

Shortcut:    ALT+T (toggles the Test Icon on or off)



Options | Border Flood Fills
Allows the Paint Roller tool to fill to a defined border color. (Toggles on or off)

Normally, the Paint Roller tool will fill a region specified by a given color.    Border Flood Fill
allows the fill operation to proceed until a defined border color is reached.    This is 
particularly useful for filling areas composed of dithered patterns.

Once you have selected the command, you will notice a small B appear on the Paint Roller
tool button.    Next, select the color you would like to fill an area with by clicking the 
primary mouse button over that color in the palette.    Next, select the color that Icon 
Creator will use as the border color by clicking the secondary mouse button on that color.  
Now, position your cursor over the area you want to fill and click the primary mouse 
button.    

For this tool to function properly, the area in question MUST be surrounded by a solid 
color not contained within the area.    The flood fill will treat the background color as the 
border and the foreground color as the replacement color.

If you do not get what you expected, simply select the Edit | Undo command.

Shortcut:    ALT+B (toggles on or off)



Options | Smooth Pen Drawing
Toggles Smooth Pen Drawing (contiguous mode) on or off

 When using the Pen or Eraser tool, moving the pen across the Icon Work Area very 
quickly will not give you a completely connected line.    Instead, you will see a broken line. 
This is due to the nature of the Windows multi-tasking environment.    This option (on by 
default), will force operations with the Pen or Eraser tool to be unbroken.    

Note:    Sometimes, some interesting effects can be achieved by having this option off.    
These effects can look similar to an "airbrush effect."    Don't hesitate to experiment with 
each option to see which setting best meets your needs. 



Options | Tools Squaring
Restricts the use of certain tools to draw perfectly straight lines at 90 degree 
or 45 degree angles.

Sometimes drawing perfect squares, perfect circles, and lines at perfect 90 or 45 degree 
angles is difficult to do freehand.    This command allows you to "constrain" certain tools to
produce ONLY perfectly "squared" images.    Executing the command will produce a dialog 
box listing all of the tools that squaring will effect.    To set squaring for a given tool, simply
click on the box next to the tool to display a checkmark.

After selecting the tools you would like squared, you will notice a thin red line surrounding
the tool.    This indicates that Tool Squaring is active for that tool.    As mentioned, Tool 
Squaring effects different tools in different ways.    The squared Line Tool will produce lines
at only 90    and 45 degree angles.    The Hollow and Filled Rectangle Tools, as well as the 
Scissors Tool, will only produce perfect squares.    The Hollow and Filled Ellipse Tools will 
only create perfect circles.    And all lines drawn by the Hollow and Filled Polygon Tools will 
be at 90 degree and 45 degree angles. 

Shortcut:    Clicking on a tool button with the secondary (right) mouse button will square 
the tool.    You will note the same thin red highlight line around the tool just as if that tool 
had been selected with the dialog box.    Clicking on the tool button again with the 
secondary mouse button will toggle squaring off.



Options | Undo From Last Selected Tool
Sets the Undo / Redo mode to the last selected tool. (Toggles on or off)

This command adds even more flexibility to the Edit | Undo and Edit | Redo commands.    
Without this command active, the undo (or redo) command will return you to the point 
just prior to the last drawing operation.    This option lets you undo (or redo) to the point 
just prior to the selection of the current tool.

For example, let's say you are adding several boxes to an icon.    Then you select the 
ellipse tool and add a few circles.    You change your mind and select Undo.    Normally, 
only the last ellipse would be undone.    However, if you had selected this option, you 
would return to the point before you had drawn any ellipses.



Options | Automatic Image Control
Automatically selects the appropriate icon image for your graphics capabilities. 
(toggles on or off)

Automatic Image Control (AIC) simplifies some of the complexities of dealing with icons.    
Each icon can have multiple images, each image targeted to a specific display type.    
Most users only want to work with the icon image targeted for their display (most often 32
x 32 pixels, 16 colors).    This feature allows the user to view most icons as having only 
one image, even if more than one image type is physically present in the icon.

When an icon is opened from an Icon file (.ICO), AIC will ensure that you have an image 
which matches your display capabilities (a new one will be created if there is not one 
available for your display type.)    However, if an icon is opened from an Application / 
Library file,    AIC will choose the nearest existing image if there is not one available for 
your display type.

When AIC is turned off, a new menu bar item appears, the Image Menu.    This allows the 
sophisticated user full access to all the images in an icon.

For more details, please refer to the Icon Creator User's Guide.



Options | Edit Dithered Colors
Allows for creation of customized colors and patterns.

Dithered colors are actually simulated colors produced by combining one or more of the 
16 standard colors.    There are 8 dithered colors available, and each dithered color may 
be edited so that you can create your own colors and patterns.      These patterns can be 
saved for later use. 

When editing a color, you select a combination of red, green, and blue values, ranging 
from 0 to 255.    The simplest way to create new colors is to use the scroll bars.      Each 
time you modify the red, green, or blue color components, the new color will be displayed 
in the dialog box.    If you wish to use the new color in Icon Creator, simply select the OK 
button.    If you wish to reset a color to it's original value, select the Reset button.

Shortcut:    While there is no keyboard shortcut for editing dithered colors, calling up the 
editing dialog box is as easy as double-clicking on the dithered color you wish to edit.



Options | Save Dithered Palette
Saves a set of customized dithered colors for later use.

Once you have created a color combination or pattern you like, Icon Creator makes it 
possible to save the entire palette for use later.

Refer to Options | Edit Dithered Palette for more information.



Options | Load Dithered Palette
Loads a previously saved dithered palette.

A dialog box will allow you to search for, preview, and load previously saved dithered 
palettes.    Icon Creator comes with a set of predefined dithered palettes for your use.

Refer to Options | Edit Dithered Palette for more information.



Options | Set Cursor Hotspot
Allows you to indicate where a cursor's focal point or "hotspot" is to be located.

When creating a cursor, you must specify a focal point or "hotspot" that controls where 
the cursor must be to execute commands.    In a typical arrow cursor, the hotspot would 
be at the tip of the arrow.

To set the hotspot, simply select this command.    The cursor will turn to crosshairs, and 
the existing hotspot will be indicated by a red pixel in the Icon Work Area.    Position the 
cursor in the Icon Work Area where you wish to place the hotspot and single click.    The 
new hotspot will be displayed for approximately one second.

Shortcut:    ALT+H



Options | Set Preferences
Allows you to customize certain Icon Creator program settings to suit your 
personal tastes.

If Icon Creator's default settings do not suit your personal preferences, you can modify the
program to have your favorite commands set to your liking whenever you execute the 
program.    For a detailed list of what settings are saved via this command, please refer to 
the README.TXT file included on the installation diskette or the Icon Creator User's Guide.

There are four options available:

1) Save Settings On Exit    -- This will update your settings each and every time you exit 
Icon Creator.

2) Do Not Save Settings On Exit -- this is useful when you normally save settings on every 
exit, but decide to retain the last saved settings as your default. i.e, you want to quit the 
current session without saving, leaving the previous settings unchanged.

3) Save Current Settings As Default -- This will save the current environment as your 
default to be used whenever you start Icon Creator.

4) Reset to Default Settings -- This will restore the default settings to those supplied when
Icon Creator was initially installed. 



Special-Effects Menu
These commands allow you to manipulate icons and cursors, or sections of them, making 
them more symmetrical and attractive.    Many of these options will work on the entire 
icon or cursor, or on areas specified with the scissors tool.    The default is the entire work 
area.

For more information, select the Special-Effects Menu command name.

Invert Colors
Cycle Colors
Flip Horizontal
Flip Vertical
Rotate
Shift
Mirror Draw
Mirror Draw Settings



Special-Effects | Invert Colors
Changes all colors displayed in the Icon Work Area to that color's complement.

Selecting this command will change every colored item currently on the Icon Work Area.    
Each color will be changed to its complement (or "opposite" color).    If you only wish to 
Invert a portion of the icon, use the Scissors tool.    With a section of the screen 
highlighted, all changes in color will be confined to the selected area.    This command 
does not effect transparent and inverse transparent colors.



Special-Effects | Cycle Colors
Allows different colors to be displayed in the Icon Work Area to determine 
which provides the best color combination.

This command brings up a dialog box which allows you to cycle the entire work area 
repeatedly through the standard color palette. 

Areas of the icon that were colored with black, white, transparent, and inverse 
transparent colors will not be changed while cycling through the colors.



Special-Effects | Flip Horizontal
Allows an image to be flipped horizontally.

This command will flip, or invert the work area on a horizontal axis. 

This command is different from the Special-Effects | Rotate command in that the work 
area is inverted (turned upside down) as it is rotated.

Using the Scissors tool will allow only the material in the selected area to be flipped.



Special-Effects | Flip Vertical
Allows an image to be flipped vertically.

This command will flip, or invert the work area on a vertical axis. 

This command is different from the Special-Effects | Rotate command in that the work 
area is inverted (turned upside down) as it is rotated.

Using the Scissors tool will allow only the material in the selected area to be flipped.



Special-Effects | Rotate
Rotates the image one quarter turn clockwise.

Selecting this command will rotate the icon or cursor 90 degrees at a time in a clockwise 
direction.    If you select this command four (4) times, you will end up where you started.

Using the Scissors tool will allow only the material in the selected area to be rotated.    The
selected area must be a perfect square.



Special-Effects | Shift
Allows you to shift an image in any direction.

Selecting this command will display a small control box above the Icon Preview Area.    
Simply press one or more of the arrow keys to shift    your artwork in the direction of the 
arrow.

The Shift command has a built-in "wrap" feature which means if you shift an image too 
far, it will reappear on the opposite side.    This is useful for creating unusual effects and 
also frees you from worrying about shifting an image right off the work area.    

The Shift command works on the entire work area or on portions which have been 
selected using the Scissors Tool.

This command is ideal for getting your artwork centered and lined up.



Special-Effects | Mirror Draw
Allows the creation of symmetrical drawings and figures using reflected, or 
mirrored patterns.

Creating symmetrical lines and figures is simple when using Mirror Draw.    Basically this 
means that, when this command is active, whatever is drawn on one portion of the 
screen, is reflected on another portion of the screen.    It is like placing a mirror across the 
icon and having each of your cursor movements reflected in the mirror.

There are many uses for this tool ... such as drawing anything with two symmetrical 
halves (people, animals, arrows, etc.), and for creating visually arresting kaleidoscopic 
effects.

When Special-Effects/Mirror Draw has been turned on, it uses the setting found in the 
Special-Effects | Mirror Draw Settings option to determine how "the mirror is to be laid" on
the Icon Work Area, or in other words, how will modifying a portion of the screen effect all 
other sections of the screen.    This command toggles on and off each time it is selected.

Mirror Draw is available with the Pen, Line, Rectangle, and Ellipse tools.

Shortcut:    ALT+M



Special-Effects | Mirror Draw Settings
Provides the settings used by the Mirror Draw command.

By selecting this command, you are presented with a dialog box that lists all of the 
possible ways in which "mirrors" can be placed on the Icon Work Area.    

The effects of Horizontal, Vertical, Left-Right Diagonal, and Right-Left Diagonal will simply 
mirror (copy) whatever you draw on the opposite plane.    The Inverse Diagonal will also 
invert the image as it is copied.    The Kaleidoscopic Effect will enable Horizontal, Vertical, 
and Inverse Diagonal simultaneously to allow the creation of some interesting artwork. 
For a detailed explanation of the mirroring effects of these settings, see the Icon Creator 
User's Guide.

Don't forget you need to enable Mirror Draw for the settings to take effect!



Image Menu
The Image Menu is only available when Automatic Image Control is disabled.    This menu 
allows full support of multi-image icons.

For more information, select the Image Menu command name.

New
Open
Delete



Image | New
Adds a new image to the current icon.

This command will add a new image type to the current icon.    You are presented with a 
dialog box which lists the available image types.    You will be given the option of copying 
the current image to the new one, which can save considerable time when creating multi-
image icons. 



Image | Open
Opens an existing image in the current icon.

This command will open an existing image in the current icon.    You are presented with a 
dialog box which lists all available images.



Image | Delete
Deletes an image from the current icon.

This command will delete the current image from an icon.    After the image is deleted,    
you will be presented with a dialog box to choose the next image to open.    If the current 
image is the only image in the icon, you will be prompted to select a New Image.



Help Menu
The Help Menu    will direct you to information to further your skills in using Icon Creator.

For more information, select the Help Menu command name.

Help Index
Context Sensitive Help
About



Help | Help Index
Provides an index to the help files to assist you in locating answers to your 
questions.

Selecting the Help/Help Index command will bring up a screen listing the major headings 
of Help that is available for you.    By clicking on the desired topic, you will bring up the 
help screen that deals specifically with the area of concern.    All help screens are also 
cross referenced, making it easy to get help on related topics. 

Shortcut:    F1



Help | Context-Sensitive Help
Allows brief one-sentence descriptions of commands or screen functions to be 
displayed.

By selecting this command, you bring up a window that displays one-sentence 
descriptions of whichever portion of the screen you happen to be pointing at with the 
cursor.    As the cursor is moved from window to commands or to menu items, this line will
automatically update itself and provide you with a brief description of that portion of the 
screen.

Shortcut:    Shift+F1



Help | About
Displays copyright and version information about Icon Creator.

By selecting this    command, a simple dialog box appears listing the copyright information
and product version number of your copy of Icon Creator.    Clicking the OK button will put 
the box away and allow you to continue with your work.





Pen Tool
Used for freehand drawing as well as performing detailed pixel by pixel work.    
This tool is the default tool selection when Icon Creator is executed.

When positioned over the Icon Work Area, the Pen tool's cursor is an arrow pointing to the
upper left portion of the screen.    To change one pixel, position the cursor on the Icon 
Work Area and click the mouse button corresponding to the desired color.    By clicking and
dragging the mouse, a freehand line is drawn in the selected color.

Mouse Buttons:    Primary button produces the primary (foreground) color while the 
secondary button produces the secondary (background) color.



Flood Fill (Pour) Tool
Allows an area of an icon defined by a specific color to be changed to (or "filled 
with") a different color or pattern.

When positioned over the Icon Work Area, the Paint Roller's cursor becomes a paint 
bucket pouring over the work area.    To fill an area, position the cursor over the area to be
changed and select the desired mouse button.    The entire area that is of the same color 
and is bordered by any other color will be filled.      

If a flood operation fills more than you expected, it is because there was a gap that 
allowed the color to "leak" outside, so be sure the area you wish to fill is completely 
enclosed.    If you make a mistake, simply use the Edit | Undo command.

If you wish to fill an area that has previously been filled with a dithered color (pattern), 
you must first select the Options | Border Flood Fill command.    See a complete 
description of this command under the Options menu bar section.

Mouse Buttons:    Primary button fills area with the primary (foreground) color while the 
secondary button fills with the secondary (background) color.



Line Tool
Creates lines of varying widths, colors, and lengths.

When positioned over the Icon Work Area, the Line tool's pointer becomes a crosshair 
cursor.    Clicking the mouse button will select the starting point of the line.    By dragging 
the mouse, you will see an inverse-color line extend from the "anchored" starting point as 
you move the cursor around the work area.    Position the on the desired "end point" and 
release the mouse button.    A straight line of the color you selected will appear.

Mouse Buttons:    Clicking on the tool button with the secondary mouse button will cause 
Tool Squaring to be active for the Line tool (See Options | Tools Squaring for more 
information).    Holding down the SHIFT key while drawing will temporarily force Tool 
Squaring on or off (depending on its current state).    When working with the icon, the 
primary button produces the primary (foreground) color while the secondary button 
produces the secondary (background) color.    When dragging to form a line, clicking the 
unused mouse button will cancel the selection.    



Hollow Rectangle Tool
Draws an outline of a rectangle with varying colors and dimensions.

When positioned over the Icon Work Area, the Hollow Rectangle tool's pointer becomes a 
crosshair cursor.    Clicking the mouse button will select the starting point (or corner) for 
the rectangle.    By dragging the mouse in any diagonal direction, an inversecolor outline 
will appear, letting you see the size and shape of the rectangle as you move the mouse 
around the work area.    Once the rectangle is sized and positioned where you wish, 
releasing the mouse button will cause an outlined rectangle of the color you selected to 
appear.

When the Options | Tools Squaring command is active, the Hollow Rectangle tool will only 
draw perfect squares.    The Brush width setting determines how wide the outline will be.

Mouse Buttons:    Clicking on the tool button with the secondary mouse button will cause 
Tool Squaring to be active for the Hollow Rectangle tool (See Options | Tools Squaring for 
more information).    Holding down the SHIFT key while drawing will temporarily force Tool 
Squaring on or off (depending on its current state).    Holding the CTRL key while drawing 
will allow the origin of the rectangle to be moved.    When working with the icon, the 
primary button produces the primary (foreground) color while the secondary button 
produces the secondary (background) color.    When dragging to form the rectangle, 
clicking the unused mouse button will cancel the selection.



Solid Rectangle Tool

Draws a solid rectangle with varying colors and dimensions.

When positioned over the Icon Work Area, the Solid Rectangle tool's pointer becomes a 
crosshair cursor.    Clicking the mouse button will select the starting point (or corner) for 
the rectangle.    By dragging the mouse in any diagonal direction, an inverse color outline 
will appear, letting you see the size and shape of the rectangle as you move the mouse 
around the work area.    Once the rectangle is sized and positioned where you wish, 
releasing the mouse button will cause a filled rectangle of the color you selected to 
appear.

When the Options | Tools Squaring command is active, the Solid Rectangle tool will only 
draw perfect squares.    The Brush width setting determines how wide the outline will be.

Mouse Buttons:    Clicking on the tool button with the secondary mouse button will cause 
Tool Squaring to be active for the Filled Rectangle tool (See Options | Tools Squaring for 
more information).      Holding down the SHIFT key while drawing will temporarily force Tool
Squaring on or off (depending on its current state).    Holding the CTRL key while drawing 
will allow the origin of the rectangle to be moved.      When working with the icon, the 
primary button produces the primary (foreground) color while the secondary button 
produces the secondary (background) color.    When dragging to form the rectangle, 
clicking the unused mouse button will cancel the selection.



Hollow Ellipse Tool
Draws an outline of an ellipse of varying sizes and colors.

When positioned over the Icon Work Area, the Hollow Ellipse tool's pointer becomes a 
crosshair cursor.    Clicking the mouse button will select the starting point for the ellipse.    
By dragging the mouse in any diagonal direction, an inverse-color outline will appear, 
letting you see the size and shape of the ellipse as you move the mouse around the work 
area.    Once the ellipse is sized and positioned where you wish, releasing the mouse 
button will cause an outlined ellipse of the color you selected to appear.

When the Options Tools Squaring command is active, the Hollow Ellipse tool will only draw
perfect circles.    The Brush width setting determines how wide the outline will be.

Mouse Buttons:    Clicking on the tool button with the secondary mouse button will cause 
Tool Squaring to be active for the Hollow Ellipse tool (See Option/Tools Squaring for more 
information).    Holding down the SHIFT key while drawing will temporarily force Tool 
Squaring on or off (depending on its current state).    Holding the CTRL key while drawing 
will allow the origin of the ellipse to be moved.      When working with the icon, the primary
button produces the primary (foreground) color while the secondary button produces the 
secondary (background) color.    When dragging to form an ellipse, clicking the unused 
mouse button will cancel the selection.



Solid Ellipse Tool
Draws a solid ellipse of varying sizes and colors.

When positioned over the Icon Work Area, the Solid Ellipse tool's pointer becomes a 
crosshair cursor.    Clicking the mouse button will select the starting point for the ellipse.    
By dragging the mouse in any diagonal direction, an inverse-color outline will appear, 
letting you see the size and shape of the ellipse as you move the mouse around the work 
area.    Once the ellipse is sized and positioned where you wish, releasing the mouse 
button will cause a filled ellipse of the color you selected to appear.

When the Options Tools Squaring command is active, the Solid Ellipse tool will only draw 
perfect circles.    The Brush width setting determines how wide the outline will be.

Mouse Buttons:    Clicking on the tool button with the secondary mouse button will cause 
Tool Squaring to be active for the Solid Ellipse tool (See Option | Tools Squaring for more 
information).      Holding down the SHIFT key while drawing will temporarily force Tool 
Squaring on or off (depending on its current state).    Holding the CTRL key while drawing 
will allow the origin of the ellipse to be moved.      When working with the icon, the primary
button produces the primary (foreground) color while the secondary button produces the 
secondary (background) color.    When dragging to form an ellipse, clicking the unused 
mouse button will cancel the selection.



Hollow Polygon Tool
Draws an outline of a complex, multi-sided image with varying colors and 
dimensions.

When positioned over the Icon Work Area, the Hollow Polygon tool's pointer becomes a 
crosshair cursor.    Clicking the mouse button will select a starting point.    By dragging the 
mouse in any direction, an inverse-color outline will appear, allowing you to position the 
first side of the polygon where you wish.    Releasing the mouse button "anchors" the first 
side of the polygon.    The "end point" of the first side then becomes the "starting point" of
the second side.    Move the mouse to the end point of the second side and click.    You will 
again see a line appear, allowing you to drag the mouse to select the appropriate position
for the second side.    This process can be repeated as many times as you wish until the 
polygon is complete.    The polygon tool allows you to cross over previously drawn lines of 
the figure.    Once the figure suits your taste, there are two ways to complete the polygon. 
One is to double-click the mouse button anywhere inside the Icon Work Area.    The other 
is to "close" the figure by ending a segment at the start of your first segment.    Once the 
polygon is closed, all inverse colored lines change to the selected color and figure is 
complete.

The polygon tools can be used to create various figures such as triangles, hour-glass 
shapes, octagons, and many other multi-sided figures.

When the Options | Tools Squaring command is active, the Hollow Polygon tool will only 
draw lines at perfect 90 degree and 45 degree angles.      The Brush width setting 
determines how thick each side will be.

Mouse Buttons:    Clicking on the tool button with the secondary mouse button will cause 
Tool Squaring to be active for the Hollow Polygon tool (See Options | Tools Squaring for 
more information).      Holding down the SHIFT key while drawing will temporarily force Tool
Squaring on or off (depending on its current state).      When working with the icon, the 
primary button produces the primary (foreground) color while the secondary button 
produces the secondary (background) color.    When dragging to form the polygon, clicking
the unused mouse button will cancel the selection.



Solid Polygon Tool
Draws a solid complex, multi-sided image with varying colors and dimensions.

When positioned over the Icon Work Area, the Solid Polygon tool's pointer becomes a 
crosshair cursor.    Clicking the mouse button will select a starting point.    By dragging the 
mouse in any direction, an inverse-color outline will appear, allowing you to position the 
first side of the polygon where you wish.    Releasing the mouse button "anchors" the first 
side of the polygon.    The "end point" of the first side then becomes the "starting point" of
the second side.    Move the mouse to the end point of the second side and click.    You will 
again see a line appear, allowing you to drag the mouse to select the appropriate position
for the second side.    This process can be repeated as many times as you wish until the 
polygon is complete.    The polygon tool allows you to cross over previously drawn lines of 
the figure.    Once the figure suits your taste, there are two ways to complete the polygon. 
One is to double-click the mouse button anywhere inside the Icon Work Area.    The other 
is to "close" the figure by ending a segment at the start of your first segment.    Once the 
polygon is closed, all inverse colored lines change to the selected color, the interior is 
filled with the selected color, and figure is complete.

The polygon tools can be used to create various figures such as triangles, hour-glass 
shapes, octagons, and many other multi-sided figures.

When the Options | Tools Squaring command is active, the Solid Polygon tool will only 
draw lines at perfect 90 degree and 45 degree angles.      The Brush width setting 
determines how thick each side will be.

Mouse Buttons:    Clicking on the tool button with the secondary mouse button will cause 
Tool Squaring to be active for the Solid Polygon tool (See Options | Tools Squaring for more
information).      Holding down the SHIFT key while drawing will temporarily force Tool 
Squaring on or off (depending on its current state).    When working with the icon, the 
primary button produces the primary (foreground) color while the secondary button 
produces the secondary (background) color.    When dragging to form the polygon, clicking
the unused mouse button will cancel the selection.



Eraser Tool
Selectively erases (i.e., replaces) a given color with an alternate color.

To be accurate, the eraser tool does not actually erase a color, but changes a target color 
with a specified replacement color.    If you wish to selectively erase or change a particular
color in an icon or cursor, be sure that the color you want erased is selected as the 
foreground color.    The currently selected background color acts as the replacement color. 
When you have selected your target and replacement colors, selecting the Eraser tool and
moving it to the Icon Work Area will cause the cursor to change into a small, transparent 
rectangle.    This tool will only have an effect if you are holding the mouse button down 
while the cursor is over a pixel that matches the foreground color selection.    When a 
matching color is found, that pixel is changed to the replacement color.

The Eraser tool is excellent for performing detailed work.    If you wish to alter a larger 
area, simply select a thicker brush width, and hold the mouse button down while moving 
it over the target area.

It is important to note that the Eraser tool will not erase dithered colors.    However, 
interesting effects can be achieved by replacing one of the solid colors that make up the 
pattern and replacing it with a different solid color.    If you wish to completely erase an 
area filled with a dithered color, it is recommended that you use the Options | Border 
Flood Fill command and the Paint Roller tool.

Mouse Buttons:    Either mouse button performs the same function when erasing portions 
of the work area.



Scissors Tool

Allows specific portions of the icon or cursor to be selected for special 
functions.

This tool is used for defining a specific area of an icon or cursor which you would like to 
perform a    command    on.    For example, if you would only like to clear a small portion of 
the work area , you use the Scissors tool to select the area you would like clear and 
execute the Edit | Clear command.    Only the section of the work area you selected with 
the scissors tool will be cleared.

You operate the Scissors much like you would when drawing a rectangle.    When you 
position the cursor over the Icon Work Area after the tool has been selected, the pointer 
becomes a crosshair cursor.    By clicking, you select a corner "anchor point."    As you drag
the cursor around the work area, you will see a dashed rectangle, which outlines the 
selected area.    Unlike the rectangle tool, when you finish sizing and performing your 
functions on the selected area, the outline will remain in the Icon Work Area.    This area 
will then be used for functions under the Edit and Special-Effects menus. 

Once an area is outlined, it may be easily relocated by placing the mouse inside the 
selection area (the cursor will change to a 4-way arrow).    By clicking within the area, you 
can drag the selection from one portion of the work area to another.    This allows you to 
move blocks within the work area.    To do this, select the area you would like to move and
execute the Edit | Cut command.    You will notice that the selected area is filled with the 
currently selected background color.    Now, click the cursor inside of the selected area 
and move it to its new location.    When you execute the Edit |    Paste command, you will 
see that the block you selected has been relocated to its new area.

If you wish to select the entire work area, simply click once anywhere within the Icon Work
Area.    If a selected rectangle is already defined, simply click outside of that rectangle 
(but still inside the Icon Work Area), or click once on the Scissors Tool icon on the Menu 
Bar.

Mouse Buttons:    Clicking on the tool button with the secondary mouse button will cause
Tool Squaring to be active for the Scissor tool (See Options | Tools Squaring for more 
information).        Holding down the SHIFT key while drawing will temporarily force Tool 
Squaring on or off (depending on its current state).    Holding the CTRL key while drawing 
will allow the origin of the rectangle to be moved.      Either mouse button operates exactly
the same when using the Scissors tool.    When dragging to form the selection area, 
clicking the unused mouse button will cancel the selection.




